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Figure 1: P keys (Vector Red, Vector Blue, and Vector PC) 
and their MIDI Notes 

Figure 2: Playback device keys and QKeys are described 
in the MIDI tables by their location (Top, Middle, Bottom) 
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MIDI Note Off table

MIDI Note Off table 

Command Note Off#

(not used) 0

CUT (SHIFT + COPY) 1

UPDATE 2

SHIFT + FREE (Free All) 3

SHIFT + PB RELEAS 
(PB Release All)

4

HOME 5

INTENSITY 6

BEAM 7

Bottom key PB 10 off 8

SELECT (playback 1) 9

SELECT (playback 2) 10

SELECT (playback 3) 11

SELECT (playback 4) 12

SELECT (playback 5) 13

SELECT (playback 6) 14

SELECT (playback 7) 15

SELECT (playback 8) 16

SELECT (playback 9) 17

SELECT (playback 10) 18

SELECT QKey 1 19

SELECT QKey 2 20

SELECT QKey 3 21

SELECT QKey 4 22

SELECT QKey 5 23

SELECT QKey 6) 24

SELECT (QKey 7) 25

SELECT (QKey 8) 26

SELECT (QKey 9) 27

SELECT (QKey 10) 28

SCROLL WIN 29

S(PB page up) 30

T(PB page down) 31

HIGHLIGHT 32

LOWLIGHT 33

GROUP 34

QLIST 35

ACTIVE 36

Top key PB 4 37

Top key PB 5 38

Top key PB 6 39

Top key PB 7 40

Top key PB 8 41

Top key PB 9 42

MOUSE 43

(not used) 44

Bottom QKey 2 45

Bottom QKey 3 46

Bottom QKey 4 47

Bottom QKey 5 48

MIDI Note Off table (continued)

Command Note Off#



Compulite
MIDI tables

402 

Bottom Q key 6 49

S(STEP UP) (tool bar) 50

T(STEP DOWN) (tool bar) 51

Top key PB10 52

Bottom QKey 7 52

Bottom QKey 8 54

IMAGE 55

(not used) 56

Bottom QKey 1 57

Bottom QKey 9 58

Bottom QKey 10 59

Top key PB1 60

Top key PB2 61

Top key PB3 62

Middle key PB1 63

Middle key PB2 64

Middle key PB3 65

Middle key PB4 66

Middle key PB5 67

Middle key PB6 68

Middle key PB7 69

Middle key PB8 70

Middle key PB 9 71

Middle key PB 10 72

Bottom key PB 1 73

Bottom key PB 2 74

Bottom key PB 3 75

MIDI Note Off table (continued)

Command Note Off#

Bottom key PB 4 76

Bottom key PB5 77

Bottom key PB 6 78

Bottom key PB 7 79

Bottom key PB 8 80

Bottom key PB 9 81

Bottom key PB 10 82

Bottom key PB 1off 83

Bottom key PB 2 off 84

Bottom key PB 3 off 85

Bottom key PB 4 off 86

Bottom key PB 5 off 87

Bottom key PB 6 off 88

Bottom key PB 7 off 89

MACRO 90

Bottom key PB 8 off 91

Bottom key PB 9 off 92

SELECT PB 1off 93

SELECT PB 2 off 94

SELECT PB 3 off 95

SELECT PB 4 off 96

SELECT PB 5 off 97

- @ (tool bar button) 98

SELECT PB 6 off 99

SELECT PB 7 off 100

SELECT PB 8 off 101

SELECT PB 9 off 102

MIDI Note Off table (continued)

Command Note Off#
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SNAP GO 103

SELECT PB 10 off 104

SELECT QKey 1 off 105

SELECT QKey 2 off 106

SELECT QKey 3 off 107

SELECT QKey 4 off 108

SELECT QKey 5 off 109

SELECT QKey 6 off 110

SELECT QKey 7 off 111

(not used) 112

SOLO 113

LIB 114

POSITION 115

LIB (tool bar) or
SHIFT +LIB

116

PB PARAM (fader mode) 117

SELECT QKey 8 off 118

SELECT QKey 9 off 119

SELECT QKey 10 off 120

SNEAK 121

(not used) 122

SNAP 123

- (minus) 124

(not used) 125

SHIFT + SNAP GO 126

(not used) 127

MIDI Note Off table (continued)

Command Note Off#
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MIDI Control Change table

MIDI Control Change table 

Command Control 
change

(not used) 0

Bottom QKey 1 off 1

Bottom QKey 2 off 2

Bottom QKey 3 off 3

Bottom QKey 4 off 4

Bottom QKey 5 off 5

Bottom QKey 6 off 6

Bottom QKey 7 off 7

Bottom QKey 8 off 8

Bottom QKey 9 off 9

Bottom QKey 10 off 10

Top key PB1 off 11

Top key PB2 off 12

Top key PB3 off 13

Top key PB4 off 14

Top key PB5 off 15

Top key PB6 off 16

Top key PB7 off 17

Top key PB8 off 18

Top key PB9off 19

Top key PB10 off 20

Middle key PB1 off 21

Middle key PB2 off 22

Middle key PB3 off 23

Middle key PB4 off 24

Middle key PB5 off 25

Middle key PB6 off 26

Middle key PB7 off 27

Middle key PB8 off 28

Middle key PB9 off 29

Middle key PB10 off 30

MOVE 31

SHIFT + GO (PB 
control) 

32

GO (PB control) 33

ON (PB control) 34

PB RELEASE off 35

PB controls OFF (except 
PB RELEASE) 

36

PRIO 37

JOIN 38

STEP 39

Q (PB control) 40

 II W  (PB control) 41

SHIFT + BLIND 42

MEDIA SERVER 43

MIDI Control Change table (continued)

Command Control 
change
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MIDI Notes for triggering macros

MIDI Notes for operating playback controls

MIDI Note ON for triggering CONSOLE 
MACROS 

Command MIDI Note On

MACRO 101 62

MACRO 102 61

MACRO 103 60

MACRO 104 59

MACRO 105 58

MACRO 106 57

Macro 901 97

Macro 902 98

Macro 903 99

Macro 904 100

Macro 905 101

Macro 906 102

Macro 907 105

Macro 908 106

Macro 909 107

Macro 910 108

Macro 911 111

Macro 912 112

Macro 913 4

Macro 914 118

Macro 915 119

Macro 916 121

Macro 917 122

Macro 918 123

Macro 919 124

Macro 920 125

For more information about.Macros (see 
page 299)

MIDI Note ON for triggering CONSOLE 
MACROS 

Command MIDI Note On

MIDI Notes for triggering 
PLAYBACK CONTROLS

Command MIDI Note

FREE MIDI On 7

SUB(MASTER) MIDI On 6

PB RELEASE MIDI On 56

SEQ MIDI On 69

TRIGGER MIDI On 72

AB (right key) MIDI On 76

AB (left key) MIDI On 77

SHIFT + II W(Hold All) MIDI On 92

MIDI Notes for triggering 
PLAYBACK CONTROLS

Command MIDI Note
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MIDI Notes for operating master playback controls

SHIFT + FREE MIDI Off 3

SHIFT + PB RELEAS MIDI Off 4

SHIFT + GO Control Change 22

GO Control Change 33

ON Control Change 34

SHIFT + PB RELEAS off Control Change 35

PB controls OFF (except 
PB RELEASE) 

Control Change 36

PRIO Control Change 37

JOIN Control Change 38

STEP Control Change 39

Q Control Change 40

 II W Control Change 41

For more information about.Playback device 
controls (see page 199)

MIDI Notes for triggering 
PLAYBACK CONTROLS

Command MIDI Note

MIDI Notes for triggering 
MASTER PLAYBACK CONTROLS

Command

GO MIDI On 65

HOLD MIDI On 66

BACK MIDI On 67

For more information about.Master playback 
(see page 196)
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Appendix 3    Visualizers
You can pre-program a virtual show in live mode with the Vector (or Vector PC) and 3D CAD 
lighting design software running on a PC.

Connecting the console and a PC
Consoles are connected to the computer running the visualizer via their Ethernet ports. The cabling 
used depends on whether the console is connected directly to the PC or is connected to the PC via 
an Ethernet network. Wireless communication is also supported.

Connecting Vector
Use either the Data port or the Control port to connect to the computer running WYSIWYG.

Cabling and connection

After connecting to the PC, whether directly or via network equipment, there is no further 
requirement.

Verifying the connection on the PC

When the LED is on, it verifies that the physical connection is viable.

 To verify the connection on PC’s running Windows 2000 and Windows XP

 Start `(Settings) `Control Panel `  Network connections

When the connection is enabled, but not connected, it appears in blue with a red X super-
imposed.

When the connection is enabled and working, the red X does not appear.

Configuring the network
To set up communication between the PC and the console, you must set the IP addresses. 

The console and the PC must have Identical network ID numbers, Identical. subnet mask number. 

 To find the network ID for Vector

1 Open the Tools menu on Vector.

2 Tap Settings.

Connect from port Connect to Cable requirements

Data PC Crossover cable

Data Ethernet hub Standard cable

Control Ethernet hub Crossover cable

Control PC Standard cable
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3 Open the Communication tab.

4 Jot down the network ID number and the console ID number and add the number 10.

Example:

Figure 3: Vector lighting console and PC connected via an Ethernet hub

Configuring network settings on the PC

IMPORTANT!  The network ID must be identical to the console’s network ID.

 To set the IP address on the PC

 Follow your operating system’s instructions for configuring network connections. When you 
have set the PC’s IP address verify the connectivity.

 To verify connectivity

1 Press WINKEY + R.

2 In the Open field, type CMD.

3 Press Enter or click OK.

The cmd.exe is running.

4 Type: ping [IP], in our example: 90.10.15.10.

5 Press Enter.

The result should look like this: Reply from [IP]: bytes=32 times<1ms TTL=128.

6 Close the window.

Transmitting virtual connectors (VC) 
The console must be transmitting VCs in order to communicate with the visualizer.

 To enable VC transmission for Vector

1 Open the Tools menu.

2 Tap Settings.

3 Open the Communication tab.

4 Tap VC’S ENABLED.

Network ID Console ID

90.10. 59 10
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When enabled, the button’s background is light.

Note:  It is recommended to enable VC COMPRESSION to conserve network 
resources.

5 Tap OK.

The console automatically transmits all patched ports over the network.

WYSIWYG
WYSIWYG can be installed on a PC or directly on the Vector console. WYSIWYG CE is packaged 
with Vector Red. 

Installing WYSIWYG and the Compulite driver on the PC
 Requirements:

�Windows XP & 2000

�  NTFS-formatted hard drive 

�WYSIWYG dongle (SE or CE)

� Compulite driver for WYSIWYG

ATTENTION! Do not connect the WYSIWYG dongle. If it is connected remove it before 
installing the application. If you have the Standard Edition (SE), be aware that it is some-
times called Perform. This warning also appears when installing the application.

 To install WYSIWYG

1 Insert the installation disk or download the software version from http://www.cast-
soft.com `Downloads `WYSIWYG.

Download the latest release.

2 Run the installation wizard.

3 Connect the dongle when requested.

4 Reboot the computer when requested.

Note:  Do not run the WYSIWYG application yet.

 To install the Compulite driver

1 Download the Compulite driver from: http://www.compulite.com `  Downloads `  
Visualizers. 

The driver file name is: CompuliteWYSIWYG_DriverSetup.exe.

2 Run the installation wizard.

3 Read the licence terms and click Yes to continue.
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4 Choose the dongle you are using and click Next.

5 If you are using the SE (Perform) dongle, choose your console from the console list.

6 Click Finish.

Note:  It is not necessary to reboot the computer after installing the Compulite driver.

Establishing communication between Vector and WYSIWYG

Requirements

� CE dongle. If using a console (CE) dongle, you must have at least one (1) fixture patched in 
the console before connecting to WYSIWYG. The console must set to transmit VCs. 

� SE dongle. If using a standard (SE) dongle there are no patch requirements before connecting 
to WYSIWYG.

� VC transmission enabled on the lighting console. See “DMX Protocols” page 341

After completing the patch procedures, you can establish the connection between the console and 
the WYSIWYG application.

Figure 4: Connecting WYSWIG and Vector

 To connect Vector and WYSIWYG

1 In the WYSIWYG application, click the Live tab.

2 Open the Live menu.

3 Choose Device Manger.

4 Expand the Consoles node.

5 Expand the Compulite node.

6 Choose your console.
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7 Click Insert.

8 Click on the console and choose Properties.

9 In the Protocol field, change to Compulite Ethernet.

If Vector is your console, Compulite Ethernet is the only protocol available.

10 In the Address field, enter the console’s IP address.

Make sure the last byte is 10.

11 The Bind procedure, opens the communication between the VC’s defined in the console 
and the output defined in the WYSIWYG patch.

� Click on the required output.

� Click Bind.

� Select the relevant WYSIWYG ID number.

� Click Select.

� Check that the Universe column has been updated and shows the appropriate outputs.

� Repeat this procedure for all required universes.

�When the binding is complete, click OK.

12 Click Connect.

13 Verify that the status now shows Connected.

14 Click Close.

Patching

IMPORTANT!  In the WYSIWYG patch, you must set up ports. Do not use the default 
EDMX port, as this serves a different console.

IMPORTANT!  In the WYSIWYG patch, you must set up ports. Do not use the default 
EDMX port, as this serve a different console.

 To install the Compulite driver

See “install the Compulite driver” page 409.

Establishing communication

After completing the patch procedures, you can establish communication between the console and 
the WYSIWYG application. If you intend to use the auto patch feature to transfer the patch to 
Vector, see “ Patching” on page 411.

 To open communication between the console and WYSIWYG

1 In the WYSIWYG application, click on the Live tab.

2 Open the Live menu.

3 Choose Device Manger.
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4 Expand the Consoles node.

5 Expand the Compulite node.

6 Choose your Vector.

7 Click Insert.

8 Click on the console and choose Properties.

9 Check that, in the Protocol field, Compulite Ethernet is displayed.

10 In the Address field, enter the console’s IP address.

Make sure the last byte is 10.

11 The Bind procedure, opens the communication between the VC’s defined in the console 
and the output defined in the WYSIWYG patch.

� Click on the required output.

� Click Bind.

� Select the relevant WYSIWYG ID number.

� Click on Select.

� Check that the Universe column has been updated and shows the appropriate outputs.

� Repeat this procedure for all universes.

�When the binding is complete, click OK.

12 Click Connect.

13 Verify that the status now shows Connected.

14 Click Close.

Installing WYSIWYG on the Vector PC
 Requirements:

�Windows XP & 2000

�  NTFS-formatted hard drive 

�WYSIWYG dongle (SE or CE)

� Compulite driver for WYSIWYG

Finding the network ID

 To find the network ID for Vector PC

1 Press WINKEY + R for the LAN IP.

2 In the Open field, type CMD.

3 Press Enter or click OK.

The cmd.exe is running.

4 Type: IPCONFIG and the IP computer’s address.

5 Close the window.
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IMPORTANT!  If your PC has more than one network card, make sure you are entered 
the correct IP address for the correct LAN.

Installing WYSIWYG

Requirements:

� The WYSIWYG installation disk. If you do not have an installation disk, download the current 
software from the CAST website.

� The WYSIWYG dongle. 

� The Compulite driver

ATTENTION! Do not plug in the dongle yet.

 To install WYSIWYG

1 Insert the installation disk into your PC’s disk drive and follow the installation directions.

2 When the installation is complete, you are asked to go to file sntnllusb.sys. 

3 When prompted, plug in the WYSIWYG dongle.

4 Restart your computer.

IMPORTANT!  Do not run the WYSIWYG application yet!

 To install the Compulite driver

See “install the Compulite driver” page 409.

Martin Show Designer (MSD)
Requirements:

�Windows XP & 2000

�Martin Show designer software

� Compulite MSD driver. Download the driver from http://www.lighthouse.nl/download/msd/
drivers/Compulite_v4500.zip

 To connect MSD and console

1 On the lighting console, enable VC transmission.

2  Run Martin Show Designer.

3 Go to the Control menu and choose Select Driver.
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Figure 5: Martin Show Designer

4 Choose Compulite DMX.

5 Create the patch for your show on both the lighting console and on MSD.

6 Go to the Control menu and choose Follow DMX.

MSD now receives the VCs transmitted on the network.
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Capture
Capture is supplied with the Compulite driver already installed in Capture versions 3.0 and Capture 
2005. Patching must done on both the Vector console and in Capture.

 To establish communication between Capture 3.0 and Vector

1 On Capture, go to the Tools menu.

2 Choose Providers.

3 Right click on Compulite Ethernet.

4 Click Enable.

 To patch VC’s (for Capture 3.0)

1 On the lighting console, enable VC’s.

2 On Capture, go to the Setup Properties screen.

3 Right click the universe you want to patch.

4 From the shortcut menu, choose Provider.

5 Choose Setup.

6 Select the VC that the selected universe will be listening to.

 To establish communication between Capture 2005 and Vector

 There is no need to do anything special. Capture automatically recognizes the console.

 To patch VC’s (for Capture 2005)

1 On the lighting console, enable VC transmission.

2 On Capture, go to the Universes tab.

3 Click a universe in the Project Universe pane.

4 Right click a universe in the External Universes pane and then click Connect to selected 
project universe that appears in the short cut menu.

Figure 6: Connecting Capture and Vector

 To begin working

 On Capture, go to the View menu and choose Live mode.
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Appendix 4    Device Builder

About Device Builder
 The Device Builder is an application used to define devices (personalities) for Vector consoles.The 
devices can then be imported to Vector’s Patch Manager. 

You can open the Device Builder application from Vector’s Tools menu as a stand alone application 
or open it in the Patch Manager. Devices that were edited and saved when the Device Builder was 
opened from the Patch Manager are saved with the show and are not added to the device list in 
stand alone mode. You can add them to the general device library, using the SAVE TO LIBRARY 
option (See “ Saving and importing devices” page 430.)

The file extension for Vector devices is *.cvd.

Opening the Device Builder in Vector

 To open the stand alone Device Builder 

 Open Windows Start `Programs `  Compulite `  Vector `  Device Builder.

OR 

1 On Vector’s main screen, go to the Tools menu.

2 Tap . 

The Device Builder opens.

 To open the Device Builder in the patch manager

1 In the Patch Manager workspace, select the Device node.

2 Right click a device in the Devices spread sheet.

3 Choose Properties from the shortcut menu.

The Device Builder opens to the selected device.

Tip! Put a shortcut to the Device Builder on your desktop.

 To exit the Device Builder

 Tap .

The Device Builder closes.
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Figure 7: Device details tab - Vector

� The left pane shows a list of existing devices organized alphabetically by manufacturer. 

� The fields in the right pane tabs are used to edit existing devices and define new devices
:

Tab What you do here

Device details • Enter the device ID, device name, pan and tilt spans.
• Attach a bitmap picture of the device.
• Write remarks.

Parameter Setup • Map parameters to their DMX offset.
• Set step ranges and properties.
• Enter the control channel settings.
• Set external DMX devices (yoke, scroller, etc.)

Controls • Map parameters to wheel banks and layers.
• Determine wheel sensitivity.
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Building and editing devices
The work flow for building devices is:

ATTENTION! When the Device Builder is opened through the Tools menu, all device 
files open as read-only files. They cannot be edited. To edit devices open the Device 
Builder as stand-alone or through the Patch Manager.

 To build a new device

1 Make sure that the Device Details tab is on top and the device list is set for your console. 

2 Locate the folder for the fixture’s manufacturer in the device list and open it.

3 Tap NEW located on the upper button bar. 

The New Device dialog box opens.

4 Type the device’s name in the text field and tap OK. 

The device is added to the list in the folder that was selected.

5 Under Device Properties, enter a unique identifier in the Device ID field.

Note:  An error message is displayed, if the ID number that is already in use. Correct the 
identifier and continue working.

6 The text in the Short Name field is the default name for fixtures created from the device.

The short name is automatically generated using the first two letters of the device’s name. 
You can change the short name.

7 Under Extra Data, enter the pan and tilt spans.

Consult the manufacturer’s specifications for this information. 

8  Select the manufacturer from the Manufacturer combo box. If your device’s manufacturer 
does not appear in the list, select Generic. 

9 Free text can be typed in the Device Remarks field. 

Tab What you do here

Device Details • Name and identify the device.
• Each device must have a unique name and identifier. 

Device names can be up to 32 characters.

Device IDs can be up to 5 digits.

Note: ID numbers 9901 - 9999 have been reserved for user-defined 
devices.

Parameter Setup • Map parameters to their DMX offsets and edit parameters.
• Consult the manufacturer’s manual for parameters’ DMX offsets.

Wheel Assignments • Map parameters to parameter banks and wheel layers.
• Set wheel sensitivity.
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10 Optional- Display a picture of the device. Browse to the folder where the *.bmp images are 
stored and select the image.

11 Tap SAVE to save the new device. 

A message confirming a successful export is displayed. The file name and path are also 
displayed. 

12 Tap OK to confirm.

 To delete a device

1 Select a device in the device list.

2 Tap DELETE.

Note:  There is no undo when deleting devices.

3 Tap YES to confirm or NO to cancel the command.

Mapping parameter types to their DMX offsets
Each parameter must be mapped to its DMX offset. Consult the manufacturer’s specifications for 
the correct DMX offsets.

Figure 8: Parameter Setup tab

 There may be two or more instances of the same parameter type. Example: a device may have three 
color wheels. In this case, the same parameter type is mapped to three DMX offsets. In Parameter 
Properties, the parameter names are automatically set as Color Wheel, Color Wheel 2, Color Wheel 
3. 
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 To map parameters to DMX offsets

1  Tap the Parameter Setup tab. 

2 Drag a icon from the parameter list and drop it in the map cell that corresponds to its DMX 
offset. 

Consult the manufacturer’s specifications for the correct DMX offset for each parameter.

3 Repeat Step 2 until all the parameters are mapped to their DMX offsets.

4 Double click the parameter icon to open the Parameter Properties dialog box for parameter 
editing. 

5 Tap SAVE.

Note:  To configure the control channel, See “To configure the control parameter” 
page 428.

 To map external parameters

 Select the external parameter in the parameter list and drag it to the Extern area located below 
the parameter list.

 To map shared DMX offsets

Sometimes different parameter types share the same DMX offset. Example: dimmer and the 
shutter may share DMX offset 1.

1 Drag the dimmer icon from the parameter list to the cell for offset 1.

2 Drag the shutter icon from the parameter list and drop it in the cell for offset 1.

3 To view all the parameters mapped to offset 1, click the arrow for the drop down list.

Note:  The parameters are automatically assigned to separate wheels.

 To delete parameters from the DMX offset map

 Right click on the parameter and choose DELETE in the shortcut menu.
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Editing parameters
After mapping parameters to their DMX offsets, by dragging from the list and dropping in the 
appropriate DMX offset cell, you may want to edit the parameter settings. Parameters are edited in 
the Parameter Properties dialog box.

Figure 9: Parameter properties dialog box

 To open the Parameter Properties dialog box

 Double click on a parameter in the DMX offset map.

OR 

 Right click on a parameter in the DMX offset map and choose Properties.

The title bar shows the selected parameter and its DMX offset.

 To open the Parameter Properties dialog box for external dimmers

 Double click on the external parameter located below the parameter list.

Figure 10: External parameter box

OR 

 Right click and choose Properties.

The title bar shows the selected parameter and its DMX offset.
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Changing the default wheel assignment

When defining a new device, parameters are automatically assigned to wheels according to the 
parameter type, as set in the Parameter Properties dialog box: color parameters are assigned to the 
color bank, gobo parameters to the image bank, etc. 

Parameters are assigned to wheels in the order that they appear in the DMX offset map. Example: If 
the color parameter order is color wheel and color speed, then color wheel is automatically assigned 
to wheel 1and color speed to wheel 2. 

Field/Group

Type The parameter type determines the default wheel bank assignment.

Name This is the text that appears on the Wheel Assignments display in 
Vector. 
Note: This is not available for Dlite and Rave.

Bank The default wheel bank. Example: all gobo related parameters are auto-
matically assigned to the image wheel bank and all color related param-
eters are assigned to the color wheel bank. The default assignment can 
be easily changed.

Invert • Check to invert the parameter.
• Clear to uninvert the parameter.

Exclude from Lib • Check to exclude the parameter from libraries.
• Clear to include the parameter in libraries.

Profile Set the parameter’s behavior during fades.

Priority Set to LTP (Priority) or HTP.

Resolution Choose 8-bit or 16-bit resolution.

LSB Offset Set lowest significant bit for 16-bit resolution.

Edit Steps Buttons for copying, cutting, and pasting steps.

Edit Step Table Add or delete steps.

Step icon You can display an icon for the step. The icon displayed here is shown 
in the step picker. Vector only.

Offset Home Value Set the home value for the parameter. This is the value the parameter 
goes to when you press HOME or RESET. Example: Pan and tilt home 
values are usually set to 50% (128 -decimal or, in the case of 16-bit 
parameters, 32768).

Mode Set the home value display mode to percent, decimal, hexadecimal.

Step Table Shows the step settings.
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Tip! If the fixture has only a few parameters, you may want to group all parameters in the 
same wheel bank.

 To change the default wheel bank assignment

1 In the DMX offset grid, right click on a parameter. 

A short cut menu opens.

2 Choose Properties.

The Parameter Properties dialog box opens.

3 Open the Bank combo box and select another wheel bank. 

[

Figure 11: Parameter Properties tab detail

Generating steps

Some parameters, such as dimmer or cyan, have only one step. Other parameters, such as gobo 
wheels or color wheels, may have many steps. When building a new device, all parameters initially 
have only one step. Add steps using the Edit Step Table buttons.

Button What it does

BUILD STEPS Tapping Build Steps opens the Step Generator dialog box where you 
set the number of steps. DMX values (0 - 255) are automatically 
divided equally among the steps. This can be edited later.

ADD STEP Tap this button to add a step at the end of the step list. Added steps must 
be further defined in the step generator

INSERT STEP Tap this button to insert a step above the selected step.

DELETE STEP Delete the selected step.
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After setting the number of steps, fill in the Step Table fields.

Note:  Use ENTER and the arrow keys to navigate the Step Table.

 To build steps

1 Open the Parameter Properties dialog box by double clicking on a parameter in the DMX 
offset map.

 Or

Right click on a parameter in the DMX offset map and choose Properties.

The title bar shows the selected parameter and its DMX offset.

2 Tap BUILD STEPS. The Step Generator opens.

3 Fill in the fields in the Step Generator.

4 Tap BUILD STEPS to overwrite the current step table.

Step Table Fields

# (number) Enter the number of steps for this parameter.

Name Type the step’s name. For example, you might name a step in the gobo 
wheel ‘Starburst’.

Discrete Click in the cell to toggle between Yes and No.
• No - There is continuous control between steps. This is the default 

setting.
• Yes - There is not continuous control between steps. When setting 

values using the wheel, the value jumps from step to step without 
any intermediate values.

Stopper Click in the cell to toggle between Yes and No.
• No - There is no stopper between steps. This is the default setting.
• Yes - There is a stopper between steps. Use STEP UP and STEP 

DOWN, on the Editor tool bar, to move past the stoppers.

Min (from) The step’s DMX start value.

Max (to) The step’s DMX end value.

Dark Gel For color scrollers! The dark gel feature keeps two consecutive color 
frames in motion as long as the fixture’s dimmer is at more than 10% 
intensity. This saves on gel burn when using very dark colors, as no 
single area of the gel is constantly exposed to the heat of the lamp. 
When assembling the gel ribbon cut a double length for dark colors.
Scrollers are usually defined with external DMX offsets. 
Click in the cell to toggle between Yes and No.
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 To add steps

1 In the Parameter Properties dialog box, tap ADD STEP. 

The new step is added to the end of the step table. The added step is labelled New.

2 Type a text tag for the new step.

3 Manually enter the settings for discrete, stopper, and DMX values range.

 To insert steps

1 In the Parameter Properties dialog box, Step Table, tap a step to select it.

2 Tap INSERT STEP. 

The new step is added above the selected step.The added step is labelled New.

3 Type a text tag for the new step.

4 Manually enter the settings for discrete, stopper, and DMX values range.

OR 

1 Tap a step to select it.

2 Tap BUILD STEPS. The Step Generator opens.

3 Fill in the fields in the Step Generator.

4 Tap INSERT STEP RANGE. 

The new steps are added above the selected step.The new steps are labelled Step 1, Step 2, 
etc.

 To delete steps

1 In the Parameter Properties dialog box, tap a step to select it. 

2 Tap DELETE STEP. 

The number of steps is automatically adjusted to accommodate the deletion.

IMPORTANT!  The DMX offsets are NOT automatically reconfigured when you delete 
a step. You must reset them manually.

Editing steps

 To add a text tag

 In the Step Table, click the step and type the new text. 

 To change DMX values

 In the Step Table, click the Min or Max for the step and type the new values.

 To copy or cut a step

1 In the Step Table, stand on the step’s name.

2 Tap COPY or CUT.

OR 
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 In the Step Table, stand on the step’s name, right click, and choose Copy or Cut.

 To paste a step

 In the Step Table, stand on a cell where you intend to paste the step, and tap PASTE.

OR 

 In the Step Table, stand on the cell where you intend to paste step, right click, and choose 
Paste. 

Note:  The pasted step overwrites all existing information.

 To set scroller steps and dark gel

1 Open the Parameter Properties dialog box by double clicking on the external parameter.

 Or

Open the Parameter Properties dialog box by right clicking the external parameter and 
choosing Properties.

2 Click in the Dark Gel column where you have inserted a double sized frame.

Yes appears in the Dark Gel column.

3 Tap OK.

Attaching a bitmap to a step

You can display a graphic representation of the step in the Step Icon area. Vector supports *.bmp or 
*.ico files.

Note:  The graphic you choose here represents the step in the gobo or color pickers. 

 To attach a bitmap to a step

1  In the step table, select a step.

2 Browse to the folder where the *.bmp images are stored and select the bitmap.
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Configuring the control parameter
The control parameter controls the lamp on, lamp off, and reset functions of the fixture. These func-
tions are accessed via the control function on the console. The control parameter is not controlled 
by a wheel, therefore it has no wheel assignment. The control parameter is configured in the Control 
Properties dialog box.

Figure 12: Control Properties dialog box

 To configure the control parameter

1 Go to the Parameter Setup tab.

2 Open the Control Properties dialog box by tapping the control icon below the parameter 
list.

3 Check the Use Control check box. 

4 In the Offset field, enter the control channel’s DMX offset. 

 Or

Check Broadcast on all offsets.

5 In the Return Value field, enter the return value. Sometimes, the return value is called the 
safe value. The return value is usually 0. 

6 In the Name column, type the step names such as: Lamp ON, Reset, Lamp OFF. 

7 In the Value column, fill in the step’s DMX value. Example: The DMX value for Martin 
fixtures’ Lamp ON for is 228; the DMX value for High End fixtures’ Reset is 64. 

8 In the Time column, enter in the number of seconds the value is sent. This is usually 6 
seconds.
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Setting up wheel assignments 
Setting up the wheel assignments is done under the Wheel Assignments tab.

Figure 13: Wheel assignments tab

The six parameter types correspond to the six wheel banks:

When setting up the device’s parameters, each parameter type is automatically assigned to its 
default wheel bank. Each bank can have up to six layers. A single parameter can be assigned up to 8 
times. Parameter types can be assigned to any wheel bank, regardless of its default assignment.

Wheel sensitivity can be configured for each wheel and in each layer:

� 0 through 3 is coarse.

� 0 through -3 is fine.

Note:  In each wheel bank, pan and tilt are always assigned to the trackball and dimmer 
is always assigned to the vertical wheel.

 To assign parameters to wheels

Example: Assign cyan to wheel 1, magenta to wheel 2, yellow to wheel 3, and color wheel to 
wheel 4.

1 Show the Controls tab.

2 Tap on COLOR to select the color wheel bank.

3 Drag cyan from the parameter list to wheel 1.

� Intensity � Position

� Color � Beam

� Image � Shape
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4 Drag magenta from the parameter list to wheel 2.

5 Drag yellow from the parameter list to wheel 3.

6 Drag color wheel from the parameter list to wheel 4.

7 Optional: set the wheel sensitivity by double clicking on the sensitivity cell, located 
beneath the parameter name, and choose a setting from the combo box.

8 Choose another wheel bank and assign the appropriate parameters.

9 Repeat step 9 until all the parameters are assigned to wheels.

10 Tap SAVE.

 To remove a wheel assignment

 Select the parameter and drag it to the trash can or right click on the parameter and choose 
Delete from the shortcut menu.

Saving and importing devices
The save options buttons control where new and modified devices are saved and allow importing 
devices to the device library.

Figure 14: Save Options buttons

Button What it does

NEW Define a new device.

SAVE Save the selected device with the current show. 

SAVE IN • Select a folder.
• Convert a Vector device for use with Dlite / Rave or a Dlite / 

Rave device for use with Vector.

SAVE TO LIBRARY Enabled only when you open the Device Builder from Vector’s 
patch manager. This allows you to save the new or modified device 
to the device library default folder.

IMPORT TO LIBRARY Import a device definition from an external file or the show file to 
the device library default folder. 
Its name and ID number are added to the IdToNameTable, an auto-
matic Excel file that is stored in the device library default folder.

DELETE Delete the selected device.

DIRECTORY New and modified devices are saved to the default directory 
selected here.

ABOUT Shows the current Device Builder version.
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